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1. Getting Started 

1.1   Lixel CyberColor Studio Software Overview 

LixelCyberColor Studio employs a photorealistic 3D rendering method 

based on 3D Gaussian Splatting (3DGS) technology.  LCC models offer 

superior visual quality with efficient processing, proving to be a popular choice by 

professionals over mesh and photogrammetry methods. 

Key Advantages 

1. SLAM-based collection: Efficiently captures large spaces through mobile 

scanning 

2. Integrated LiDAR data: Produces more accurate structures, enabling 

measurement and spatial applications 

3. Rapid processing: Converts 5-minute scans in 100-150 minutes (1:20-30 

ratio) 

4. Compact data: Files are 80% smaller than comparable formats 

5. Extensibility: Supports measurement, annotation, editing and further 

development 

 

Lixel CyberColor Studio (hereinafter referred to as LCC Studio) is a PC-based 

tool for generating and working with photorealistic 3D modelsLCC processes 

LiDAR and visual data from Lixel scanners into high-quality 3D models in 

either .ply or proprietary .lcc formats. Models can be viewed locally or shared 

online via web links for collaborative exploration. 

Core Features: 

• Generate: Import Lixel raw data to automatically create 3D models 

in .lcc, .lcc2, .ply, .usd or 3D Tiles format 

• View: Experience models through local viewing and first-person navigation 

using LCC, LCC2, PLY, and USD models. 

• Publish: Share LCC results via web-viewable links with one-click publishing 

• Export: Export in standard .lcc, .ply, .lcc2, .usd, 3D Tiles formatTools: 

• Measurement & Annotation: Measure models and add annotations. 

Annotations support adding multimedia content from within or outside the scene. 

• Model Post-Processing: Crop, color grade, and apply other post-processing 

operations to models. 

• Asset Overlay: Import external 3D assets (.fbx, .glb, .obj) for model 

enhancement. 



• Collision: Generate models with physical collision for immersive flythrough 

and interaction. 

• Snapshot & Recording: Capture scene snapshots and render flythrough 

videos for presentations and reporting. 

• Viewpoints & Reports: Add viewpoints to guide users through specific areas. 

Generate Scene Reports to compile and present related content. 

Featured Capabilities 

•      Map Fusion: Supports multi-segment ground data stitching through 

automatic overlap region recognition for unified large-scale model reconstruction. 

•             Aerial-Ground Map Fusion: Fuses drone imagery with ground scan data 

for seamless integration of aerial and ground perspectives, suitable for building 

complexes, campuses, scenic areas, and other large-scale complex model 

reconstruction. 

•          HD Enhancement: Import high-resolution images from DSLRs or 

smartphones to enhance detail and texture in key areas, suitable for refined 

restoration of focal points. 

•         Spatial Recognition: For indoor scan data, automatically extracts spatial 

structure and building components to quickly generate structured intelligent floor 

plan outputs, suitable for spatial analysis and BIM modeling. 

•         Aerial Reconstruction: Supports 3DGS reconstruction of large-scale 

models using only drone aerial images without ground equipment capture data. 

1.2 First Use 

1.2.1 Download and Installation 

Download the software installation package through the official download link: 

https://xgrids.com/intl/support/download 

LCC Studio uses an .iso full installation package, supporting offline installation of all 

LCC modules. 

Recommended Configuration: 

• CPU: Intel i9 12th Gen or above 

• GPU: RTX 3070 or above 

• RAM: 64GB or above 

For full configuration details, see: Section 3 — Download and Installation — System 

Requirements — Reconstruction Configuration Reference. 

Registration and Authorization: 



• Free Edition: Register and log in to access Free Edition features. 

• Premium Edition: Register and log in, then contact sales to obtain an 

authorization code. Once the code is redeemed, the account activates Premium 

features. 

Premium features include: all Free Edition features, Map Fusion, Aerial 

Reconstruction, Aerial-Ground Fusion, HD Enhancement, Spatial Recognition, and 

export to .lcc, .lcc2, .ply, .usd, and 3D Tiles formats. 

 

LCC Free and Premium 

1.2.2 Data Capture 

Before using LCC Studio for 3D reconstruction, you must first scan the space using 

an XGRIDS scanner device. 

Note: LCC Studio's Map Fusion and Aerial-Ground Fusion features have specific 

data capture requirements. Follow the capture guidelines strictly during scanning. 

RTK data capture also has supplementary details to ensure scan quality and 

compatibility. 

• Capture Guide: 

https://da9i2vj1xvtoc.cloudfront.net/help/lcc/LCC+Scanning+Guide+v9.0.pdf  

• LCC Quick Start Guide: https://xgrids.com/us/support/tutorials?page=LCCStudio  

1.2.3 Reconstruction (Local / Cloud) 

On the My Models page, click Create, select the target reconstruction type, upload 

capture data following the on-screen instructions and parameters, and click Start. 

The model begins reconstruction. 

Note: Before starting reconstruction in LCC Studio, it is strongly recommended to set 

your project storage path and capture data backup path first. Keep LCC data storage 

separate from the software installation directory. Setting the storage path to an SSD 

significantly improves data generation and processing speed. 

• Set LCC project path: Settings → General → Project Path → Select Directory 

• Set LCC capture data backup path: Settings → General → Capture Data Backup 

https://da9i2vj1xvtoc.cloudfront.net/help/lcc/LCC+Scanning+Guide+v9.0.pdf
https://xgrids.com/us/support/tutorials?page=LCCStudio


Path → Select Directory 

 

Sign in 

 

Create 

 

Set LCC project path 

1.2.4 Export 

Select a completed model card, click "..." in the upper-right corner, select Export, 

follow the dialog instructions, choose the desired export format, and click OK to 

export. 

Export formats currently supported: .lcc and .lcc2 data files, .ply format, .usd format, 

and 3D Tiles format. 

 

Export 

1.2.5 Editing 

After reconstruction completes, double-click a model card to enter LCC Editor for 

editing or viewing. 

Three Navigation Modes — Quick Reference: 

 

Shortcuts 



Control Function 

Flythrough Mode 

W / A / S / D / Q / E Forward / Left / Back / Right / Down / 

Up 

Shift Sprint 

Scroll wheel Adjust movement speed 

Left-click drag Rotate view 

Right-click drag Pan view 

Avatar Mode 

Space Jump 

Left-click target Navigate to position 

Click the tools in the left toolbar to edit the model. 

After editing, switch to View mode via the upper-right menu bar toggle to review 

edited content. 

1.2.6 Publish (Share) 

Click Menu Bar → File → Publish, configure publishing options, and click Share to 

publish the edited project to the cloud. 

Share a published model: On the Editor homepage, find the published project. Click 

the link icon in the lower-right corner of the project card to copy the project's link for 

sharing with other users. 

View a published model online: Click "..." in the upper-right corner of the project 

card, then click Online View to open the link in a browser. 

Manage published models: Click "..." in the upper-right corner of the project card, 

then click Publish Management to open the cloud publishing dashboard, where you 

can manage all published links under your account. 

2. Version and Updates 

2.1 Version and Copyright Notice  



Software Version: Lixel CyberColor Studio V1.13.0 Release Date: May 6, 2026 

This manual covers LCC Studio V1.13.0. Operations may differ in other versions. 

Notes: Lixel®, XGRIDS Lixel®, Lixel CyberColor™, and related marks are registered 

trademarks of Shenzhen XGRIDS Innovation Technology Co., Ltd. Other trade 

names, company names, and brand names mentioned in this document may be the 

trademark property of their holders. 

2.2 Key Updates · Studio 

1. New K2 device support: supports K2 data import, single-scene reconstruction, 

and Spatial Recognition. 

2. New USD format export: supports exporting .usd format for the NVIDIA 

Omniverse ecosystem. 

3. New automatic device file reading: automatically detects connected devices 

and displays the project list, supporting one-click import and reconstruction. 

4. Reconstruction report optimized: Gaussian point count display changed from 

total points to LoD0 level points. 

5. Bug fixes and stability improvements. 

2.3 Key Updates · Editor 

6. Height Filter optimized: cleaner model edges after height filtering. 

7. Bug fixes and stability improvements. 

3. Download and Installation 

3.1  Installation Package Download 

Download the software installation package through the official download link: 

https://xgrids.com/intl/support/download  

3.2 System Requirements 

3.2.1 Reconstruction Configuration Reference 

Operating System: Windows 10/11 Professional or Home 

Hardware Requirements: 

Item Minimum Recommended 

System Windows 10/11 Pro/Home Windows 10/11 Pro/Home 

https://xgrids.com/intl/support/download


CPU i7 9th Gen i9 12th Gen 

GPU NVIDIA RTX 2060 (6G) NVIDIA RTX 3070 equivalent or 

above 

Memory 32GB 64GB and above 

Hard Drive 1TB 1TB (SSD) 

• CPU: No explicit minimum. Recommended mainstream level from 2017 onwards:  

￮ Intel i7 8700K or above 

￮ AMD R7 1700X or above 

• GPU: Based on VRAM requirements, suitable graphics cards include:  

￮ Server: V100 (16GB), A10 (24GB), A100 (48GB) 

￮ Desktop: RTX 2080Ti (11GB), RTX 3060 (12GB), RTX 4080 (16GB), RTX 

3090 (24GB), RTX 4090 (24GB) 

￮ Laptop: RTX 3080Ti (16GB), RTX 4080Ti (16GB) 

Recommended Configuration: 

• CPU: Intel i7 8700K or above 

• GPU: RTX 3070 or above 

• RAM: 64GB or above 

3.2.2 GPU Performance Impact on Reconstruction 

Efficiency 

High-end GPUs (e.g., RTX 4090D): Faster reconstruction speed, especially for high-

resolution and large-scale point cloud data. Maintains high processing efficiency 

under heavy data loads, reducing wait times. 

Mid-range GPUs (e.g., RTX 3060): Suitable for standard-sized point cloud data 

processing. Lower efficiency than high-end GPUs under heavy loads, but still 

provides stable performance. 

3.2.3 Memory vs Data Processing Capabilities 

64GB Memory: Stable processing of up to 30 minutes of capture data. Processing 

more than 50% above this limit (over 45 minutes) may lead to reconstruction failure. 

128GB Memory: Stable processing of up to 60 minutes of capture data. Processing 

more than 50% above this limit (over 90 minutes) may increase reconstruction failure 

risk. 



3.2.4 Hardware Requirements for Map Fusion & Aerial-

Ground Map Fusion 

Map Fusion and Aerial-Ground Fusion require robust hardware for automated high-

density multi-model alignment and intensive processing. 

a. Recommended Configuration: 

￮ Processor: AMD Ryzen 9 9950X or equivalent ≥16-core high-performance 

desktop CPU 

￮ Memory: 64GB DDR5 (96GB or 128GB recommended for larger datasets) 

￮ GPU: NVIDIA RTX 3090 (RTX 4090 or 4090D recommended for optimal 

performance) 

b. Notes: 

￮ Verify sufficient system resources before starting tasks to prevent 

interruptions or failures. 

￮ For large models (total length ≥150 minutes) requiring high-quality 

reconstruction, 96–128GB memory is recommended. If memory is insufficient, 

select Standard quality to ensure smooth processing. 

￮ Processing time currently has no fixed estimate. With the recommended 

configuration using Standard settings, estimate approximately 20 minutes of 

processing per 1 minute of capture data (1:20 ratio). 

3.3   Installation 

V1.12.0 LCC Studio uses an .iso full installation package, supporting offline 

installation of all LCC modules. 

3.4   Registration and Login 

3.4.1 Registration 

1. Launch the software to access the login page. Click Register to enter the 

registration page. 

2. On the registration page, fill in your information and click Register to complete 

registration and log in. 



 

Login page 

 

Registration 

Subscribe to XGRIDS Updates: Check the subscription box during registration to 

receive product and event news via email. Unsubscribe anytime through links in any 

email. 

3.4.2 Login 

Users can log in via password or verification code to access the platform's various 

functions. 

4. Studio 

4.1 Interface Overview and Navigation 

 

Interface overview 

1. Global Navigation 

• My Models: View and manage your models. The content list area displays 



pending and generated models as model cards. 

• Portal: View and manage historical "Portal" data. Starting from V1.12.0, the 

Portal entry is for historical content viewing only; new creation and import are no 

longer supported within this page. To create or maintain multi-scene portal 

relationships, go to My Projects in Studio and use the project workflow in Editor for 

scene editing and publishing. 

• Recently Viewed: Records all locally reconstructed models browsed in the 

software, distinguishing between .lcc and .ply model formats. 

• Settings: View and configure: Account, Advanced, General, Device, Language, 

Data & Privacy, About. 

• Featured Gallery: View curated model use cases selected by the LCC team. 

2. Quick Access 

• Create: Click "Create" to begin the LCC model reconstruction workflow. 

• Edit Model: Import exported .lcc model files and .ply format files into Studio for 

editing. 

• My Projects: Enter LCC Editor for project management and editing. 

3. Content List: Displays the primary content collection for the current module. 

4. Account Info: Displays the current logged-in account and permission 

information, including subscription status, Settings entry, Redeem Authorization Code, 

and Sign Out. 

5. Announcements: Important notices and system guides: software updates, 

feature changes, and answers to common questions. 

6. Version Info & Help 

• Software Version: Displayed in the lower-left corner for reference. 

• User Manual: Click Help to access the current version's user manual with 

detailed operation guides and FAQs. 

4.2 Pre-Reconstruction Work 

4.2.1 Data Capture 

Before using LCC Studio for 3D reconstruction, you must first scan the space using 

an XGRIDS scanner device. 

Note: LCC Studio's Map Fusion and Aerial-Ground Fusion features have specific 

data capture requirements. Follow capture guidelines strictly during scanning. RTK 

data capture has supplementary details to ensure quality and compatibility. Refer to 

the capture guide and quick start guide for detailed instructions. 

Resources: 

• Capture Guide: 



https://da9i2vj1xvtoc.cloudfront.net/help/lcc/LCC+Scanning+Guide+v9.0.pdf  

• LCC Quick Start Guide: https://xgrids.com/us/support/tutorials?page=LCCStudio  

Absolute Coordinates: LCC files from RTK-equipped devices support CGCS2000 

and WGS84 coordinate systems for geospatial platforms (e.g., Cesium). 

Developer Platform: https://developer.xgrids.com/#/  

4.2.2 Upload Capture Data 

Click Create to enter the reconstruction page. Select a reconstruction type based on 

your needs — Single Model, Map Fusion, Aerial-Ground Fusion, or Aerial 

Reconstruction — then follow the on-screen workflow to upload capture data. 

Supports uploading capture data from local storage. Also supports external USB 

drive mode for direct reading of raw capture files. 

1. Note: USB drive mode only supports reading data from local storage devices 

(including internal hard drives, SSDs, USB drives, and USB-connected external 

storage). Network storage (e.g., OneDrive, NAS) is not supported. 

2. Tip: Before starting reconstruction in LCC Studio, set your project storage path 

and capture data backup path. Keep LCC data storage separate from the software 

installation directory. An SSD is recommended for storage to significantly improve 

data generation and processing speed.  

a. Set LCC project path: Settings > General > Project Path > Select 

Directory 

b. Set capture data backup path: Settings > General > Capture Data Backup 

Path > Select Directory 

 

Create 

 

Choose reconstruction 

type 

 

Set LCC project path 

4.2.3 Automatic Device File Reading 

In addition to the methods above, LCC Studio v1.13.0 introduces automatic device 

file reading. When you connect an XGRIDS scanner device via USB, LCC 

automatically detects the external device and reads project information, simplifying 

the data import workflow. 

4.2.3.1 Workflow 

1. Connect the XGRIDS device to the computer via USB. 

https://da9i2vj1xvtoc.cloudfront.net/help/lcc/LCC+Scanning+Guide+v9.0.pdf
https://xgrids.com/us/support/tutorials?page=LCCStudio
https://developer.xgrids.com/#/


2. Once the system detects the device, a notification appears in the lower-right 

corner of the screen. Click to open the device dialog. 

3. In the device dialog, you can view: device model and SN number, importable 

project list (including project name, file size, capture date). Previously imported 

projects are grayed out and cannot be re-imported. 

4. Select the reconstruction method.  

a. Note: If the connected device is a scanner, only single-scene quick import 

and reconstruction is currently supported. 

5. Set the file storage path (defaults to the capture data backup path). 

6. Click "Start Reconstruction" to add the project directly to the reconstruction 

queue. 

4.2.3.2 Disable Auto-Detection 

Auto-detection is enabled by default.To disable: 1. Go to Settings > General. 2. 

Find the "Device" option. 3. Click Off to disable automatic device detection. 

4.3 Model Reconstruction 

After model creation, click Start to load data. Once data loading completes, the 

model appears in the My Models list. Click Start Reconstruction on the specific 

project, then click Confirm in the prompt to begin automatic model generation. 

 

Start Reconsruction 

 

Dropdown menu 

Notes: 

1. For batch reconstruction, ensure all data uploads are complete before queuing. 

Avoid running other VRAM-consuming tasks during reconstruction. 

2. Do not close LCC Studio during reconstruction, or the task will be interrupted. 

3. Ensure sufficient disk space in the LCC data storage directory — reserve at least 

2× the capture data size to prevent interruption or failure. 

4. If LCC Studio is closed during generation, the model shows as failed with its 

previous progress upon reopening. Click "..." on the model card and select Continue 



Reconstruction or Restart Reconstruction to re-enter the generation queue. 

4.3.1 Reconstruction Parameters 

1. Reconstruction Quality: Different quality settings (Fast, Standard, Slow) 

produce models with different signal-to-noise ratios. Slow reconstruction significantly 

increases VRAM consumption and extends processing time but produces higher-

quality results. 

2. Max Gaussian Points: In Single Model mode, this directly limits the total point 

count of the final reconstruction. Keep within VRAM capacity (typically ≤25M). Setting 

too high may cause VRAM shortage or performance degradation, affecting model 

quality and stability. In Map Fusion, Aerial-Ground Fusion, and Aerial Reconstruction 

modes, this setting applies only to individual block reconstruction scale and does not 

limit the final model's total Gaussian point count. The system auto-adjusts each 

block's range based on model size, so setting above 25M has no significant effect on 

overall results. 

3. Portability (Cross-Platform Optimization): Generates LCC models compatible 

with most devices. When enabled, reduces model size and improves smoothness, 

optimizing for most use cases and especially improving mobile rendering quality. 

When disabled, enables more realistic lighting effects but may cause performance 

degradation or stuttering. 

4. Debug Options: Advanced configuration parameters for power users and 

developers, used for tuning the 3D reconstruction pipeline, diagnosing anomalies, or 

handling accuracy and compatibility needs in specific scenarios. 

• Exposure Optimization: Specifically addresses floating artifacts in scenes with 

dramatic lighting changes (e.g., indoor-to-outdoor transitions). May cause slight detail 

degradation in very bright or dark areas. Enable only when encountering such issues. 

• PPR (Point Cloud Participation Rate): If sky bleeding occurs (e.g., at tree or 

building edges), try rebuilding with lower PPR. Note: Bleeding typically results from 

limited capture angles.  

Note: Supplement with multiple angles and heights during capture for best results. 

 

Before lowering - normal 

 

After lowering - low 

• RTK Data: Controls whether RTK data recorded during scanning is used in 



reconstruction:  

￮ Auto: Prioritizes RTK data. If anomalies are detected, automatically disables 

RTK to ensure stable results. 

￮ Disabled: Ignores RTK data entirely. Results will not contain absolute 

coordinate information and cannot be used for Map Fusion or Aerial-Ground 

alignment, but avoids issues caused by anomalous RTK data. 

• Special SLAM Mode: Select the SLAM mode matching your scanning 

environment for better results:  

￮ Auto (recommended): Intelligently selects the best reconstruction strategy. 

Prioritizes high-accuracy mode first; if vibration or interference causes failure, 

automatically switches to Robust mode and retries. Suitable for most scenarios. 

￮ None: Prioritizes high modeling accuracy. Suitable for stable devices and 

clear environments. Capture with vibration or interference may cause 

reconstruction failure. 

￮ Robust (default): Balances accuracy and stability with moderate 

interference tolerance during capture. Suitable for most scenarios. 

￮ Narrow Scene: Optimized for tunnels, mine shafts, long corridors, and other 

narrow environments. Using this in normal scenarios may cause failure. 

4.3.2 Pre-Reconstruction Point Cloud Preview 

After uploading capture data and before starting reconstruction, use the Point Cloud 

Preview tool to check the scan trajectory and point cloud. 

Workflow: 

1. Upload capture data → click Point Cloud Preview. 

2. The system checks each quality indicator. Review the results and adjust your 

capture data before proceeding with reconstruction to improve success rate and 

quality. 

3. After checks complete, click View Point Cloud to enter the Point Cloud Preview 

tool, where you can view the capture trajectory and coarse point cloud. 

4. Controls within the Point Cloud Preview tool are the same as LCC Editor. 

 

Shortcuts and references for previewing models 



4.3.3 Single Model Reconstruction 

Workflow 

1. Upload Capture Data Upload data files captured by XGRIDS scanner device. 

The interface displays the corresponding device type. 

 

Data Upload 

 

Display type 

2. Set Model Name and Parameters 

• Low-Memory Mode: When device memory is insufficient, enable Low-Memory 

Mode. This writes intermediate data to disk instead of keeping it in memory, reducing 

peak memory usage. May extend reconstruction time but improves stability and 

reduces failure risk from insufficient memory. Note: Low-Memory Mode is only 

available in Single Model reconstruction mode. 

Advanced Features 

1. Spatial Recognition: For indoor environments, enable Spatial Recognition. The 

system automatically identifies walls, doors, windows, and other structures, 

organizing them into a structured intelligent floor plan. Useful for spatial analysis, 

renovation planning, or BIM modeling preparation. 

2. HD Enhancement: For key areas requiring higher detail and texture quality (e.g., 

landmarks, equipment, decorative elements), use HD Enhancement. Capture 

additional high-resolution photos with a DSLR or smartphone. These photos combine 

with original scan data to enhance detail and texture quality. 

Notes: 

• Performance requirement: HD Enhancement and Spatial Recognition require 

GPU VRAM >8GB. Insufficient VRAM will prevent the features from running. 

• HD Enhancement requirements: 

￮ All supplementary photos must be taken with the same device. 

￮ Photo count: Lixel L series supports 20–500 photos; PortalCam supports 

20–1,000 photos. 



￮ Supported formats: JPG, PNG, JPEG. 

Notes on Lixel K2 Device 

• K2 currently supports Single Model reconstruction mode only. The maximum 

single-scene capture duration for is 90 minutes. 

• HD Enhancement is currently not supported. 

Note: Support for K2 devices in Map Fusion, Aerial-Ground Fusion, and other 

reconstruction types is coming soon in a future version. 

4.3.4 Map Fusion 

Map Fusion supports uploading multiple capture data segments at once, with a highly 

automated pipeline for preprocessing, calibration, matching, and intelligent stitching 

into a complete 3D model. 

Workflow: 

1. Batch Upload Multiple Capture Data Segments 

• Upload multiple data files captured by the same device type. The interface 

displays the corresponding device type.  

￮ Note: L2 Pro 16-line and 32-line versions cannot fuse together. 

• Add additional segments sequentially as needed (up to 10 segments). 

2. Set Model Name and Parameters 

 

Map Fusion 

4.3.5 Aerial-Ground Map Fusion 

Aerial-Ground Map Fusion merges drone-captured aerial imagery with ground 

scanning data for multi-perspective, multi-scale unified modeling. This enables more 

comprehensive restoration of spatial structure and detail in large-scale complex 

models, significantly improving model completeness and realism. 



Workflow: 

1. Upload Ground and Aerial Data 

• Ground Data: Upload from L or P series devices. The interface displays the 

corresponding device type. 

• Aerial Data: Select the folder containing drone photos. Requirements: 

￮ 100–10,000 images 

￮ JPG/JPEG only 

￮ Resolution >1024×768, consistent across all images 

￮ For PortalCam: upload the aerial photos and takeoff/landing point photo 

folder at the corresponding Aerial-Ground Fusion point. If fusion points were not 

set during drone takeoff/landing and only aerial photos are uploaded, there is a 

risk of degraded results or reconstruction failure. 

2. Set Model Name and Parameters 

 

Aerial-Ground Map Fusion 

 

no control points 

 

with control points 



4.3.6 Aerial Reconstruction 

Aerial Reconstruction supports 3DGS reconstruction of large-scale models using only 

drone aerial images without ground equipment capture data. 

Workflow: 

1. Upload Aerial Data 

￮ Upload drone aerial data. The interface displays the corresponding device 

type. 

2. Set Model Name and Parameters 

Aerial Data: Select the folder containing drone photos.  

Requirements:  

￮ 100–10,000 images 

￮ JPG/JPEG only 

￮ Resolution >1024×768, consistent across all images 

 

Aerial Reconstruction 

4.4 My Models 

This area contains all LCC model data you have created and uploaded, including 

pending and generated data. View, edit, and manage your models here. 



 

My Models 

4.4.1 Model Generation and Editing 

• Create: Click "Create" to begin the LCC model reconstruction workflow. 

• Edit Model: Import exported .lcc model files and .ply format files into LCC Editor 

for editing. 

4.4.2 LCC Model Management 

Three data categories: 

• All Data: All valid data categories plus all dynamic categories (reconstructing, 

exporting, publishing, paused). 

• To Be Reconstructed: Local reconstruction failures, pending reconstruction, in-

progress reconstruction, and paused reconstruction. 

• Generated: All successfully reconstructed data. 

Note: In the Generated list, double-click to enter Edit mode for direct editing; or click 

View to enter View mode. 

4.4.3 Model Settings 

Each model card has a "..." menu in the upper-right corner. Click for operations 

based on the model's current status: 

• Reconstructing: Change Cover, Cancel Reconstruction, Pause, Error Log 

Upload 

• Generated: Change Cover, Publish, Publish Management, Open File Location, 

View, Export, Report, Error Log Upload, Delete 

 



 

Reconstructing 

 

Generated 

1. Change Cover 

Customize card cover images at any reconstruction stage. 

Image requirements: 

￮ Format: JPEG / JPG / PNG only 

￮ Size: ≤ 5MB 

2. Publish: 

LCC model publishing lets you share created models with other users or groups. 

Choose between unprotected or protected sharing to control content privacy. 

• Unprotected sharing: Anyone with the link can access the model without a 

password. 

• Protected sharing: Password-protected access. Set a custom password or let 

the system auto-generate a strong password. 

• Model description (optional): Add a brief description of the model's content, 

purpose, or other relevant information for reference when managing published 

content. 

• Link generation: After clicking Create, the system generates a model link and 

allows direct copying for sharing. 

3. Publish Management: 

Click Publish Management to open the cloud publishing dashboard, where you can 

view all published links and details, and modify published link settings. 

1. Republish For published models, you can modify the following link settings: 

• Link parameters: Change the URL suffix of the model link. 

• Sharing permissions: Toggle between password-protected and public access. 

• Access password: Set or change the model's access password. 



• Model description: Update the description to provide visitors with clearer 

context. 

2. Cloud Publishing Management Manage link availability by toggling Publish or 

Unpublish to control whether the link is publicly accessible. Access via the developer 

platform. 

3. Online View View the published model online. 

4. Share Click Share to quickly copy the link and access password. 

 

Publish 

4. Open File Location 

Quickly navigate to the model file location on disk. 

5. View 

Open the model in View mode. 

6. Export 

LCC Studio supports exporting models in multiple 3DGS data 

formats: .lcc, .lcc2, .ply, .usd, and 3D Tiles. Two opitions are available when 

exporting .usd format:  

• USD (Recommended): Based on 3DGRUT, supports Omniverse Kit 110.0+, 

supports ray tracing. 

• USDZ (Forward Compatible): Based on 3DGUT, supports Omniverse Kit 

107.3+, no ray tracing. 



 

Export 

6.1 File Format Descriptions 

1. .lcc Format: 

• Exports as a set of files containing the .lcc format data. 

• Create a new folder for these files and rename it during export. 

• LCC format compresses 70–90% compared to traditional formats, improving 

storage, viewing, and application efficiency. 

• Compatible with XGRIDS Unity and Unreal Engine developer toolkits for further 

development. 

Mesh export is also supported alongside LCC export. Mesh files are triangular mesh 

models exported with LCC assets, widely used in 3D modeling and rendering. 

Currently, Mesh files do not include texture information and support .obj and .ply 

formats only. 

2. .lcc2 Format: 

Next-generation LCC data format. .lcc2 offers smaller file sizes, smoother rendering, 

and faster model loading compared to .lcc. 

3. .ply Format: 

￮ Standard point cloud format for open-source 3DGS viewers. 

￮ Compatible with UE/Unity 3DGS plugins for import and processing. 

￮ Export at different precision levels, or export all PLY data. 

4. .usd Format: 

• USD format is exported via the NVIDIA 3DGRUT toolchain, supporting ray-traced 

rendering of Gaussian point clouds. 

• Supports NVIDIA Omniverse Kit 110.0+ and Isaac Sim 5.0+. 



Note: USD format is an NVIDIA Omniverse-specific format using UsdVolVolume 

Schema custom extensions. This format cannot be rendered in general-purpose 3D 

software such as Blender, Maya, Houdini, or Cinema 4D — it is only supported in 

NVIDIA Omniverse and Isaac Sim. For general compatibility, choose a different 

export format. 

5. .usdz Format: 

• USDZ format is exported via the NVIDIA 3DGUT toolchain using the NuRec 

standard, supporting non-linear camera projection (fisheye lens / rolling shutter). 

• Supports NVIDIA Omniverse Kit 107.3+. 

Note: USD format is recommended for better rendering quality and cross-platform 

compatibility. USDZ is a forward-compatible version without ray tracing support. 

USDZ export is only available when: ① firmware version ≥ 3.0, ② Single Model 

reconstruction type. 

6. 3D Tiles Format: 

￮ Tiled 3D data format for WebGIS and digital twin applications. 

￮ Conforms to OGC 3D Tiles 1.1 standard, directly loadable in Cesium 131. 

￮ One-click export of LCC Studio reconstruction results for web display. 

Note: Currently supports Gaussian models with up to 4 million Gaussian points 

only. 

Click "OK" to complete export. 

7. Report 

View detailed data reports for each locally generated model, including 

comprehensive reconstruction information. 

8. Error Log Upload 

Upload diagnostic logs to the LCC team for analysis. Select the relevant log duration. 

Ensure the log covers the period before and after the issue for accurate diagnosis. 

4.5 Portal 

Portal is a legacy workflow entry for viewing and managing legacy "Portal" data. 

1. Current Version Status Starting from V1.12.0, the Portal entry is for historical 

content viewing only; new creation and import are no longer supported within this 

page. 

2. Alternative Workflow To create or maintain multi-scene portal relationships, go 

to My Projects in Studio and use the project workflow in Editor for scene editing and 

publishing. 

3. Legacy Content Note Existing portal projects missing required project files may 



not display or open in the list. We recommend migrating content to the new project 

workflow in My Projects for continued maintenance. 

4.6 Recently Viewed 

Records all locally reconstructed models browsed in the software, distinguishing 

between .lcc and .ply model formats. 

4.7 Featured Gallery 

View curated model use cases selected by the LCC team. 

 

Featured Captures 

4.8 My Projects 

Access LCC Editor from My Projects. In Editor, manage work content by project. 

Projects contain models, imported models, resources, and editing data for ongoing 

editing and version maintenance. 

4.9 Settings 

4.9.1 Account 

1. Change Avatar and Username: Update your display avatar and name in LCC 

Studio. 

2. Modify Account Binding: Change the phone number or email address linked to 

your account. 

3. Change Password: Update your account password. 



4. Authorization Code: Redeem authorization codes to unlock or upgrade 

features. 

5. Delete Account: Delete your account. After deletion, the account can no longer 

log in to LCC, and all associated data will be permanently removed. 

4.9.2 Advanced 

View additional professional features with detailed parameters and descriptions. 

4.9.3 General 

1. Project Path: Configure LCC reconstruction data storage location.  

Setting this to an SSD significantly improves generation and processing speed. Keep 

the data storage location separate from the software installation directory. 

2. Capture Data Backup Path: When reconstructing from external storage, data is 

backed up to this local path. An SSD is recommended for faster generation speed. 

4.9.4 Device 

View your current device and sign out of all devices. 

4.9.5 About 

Access the latest version download link and tutorials. Submit feedback or 

improvement suggestions directly to the LCC team. 

4.9.6 Language 

Switch between available languages. Currently supported: Simplified Chinese, 

Traditional Chinese (Hong Kong), English, Japanese, Italian, German, and Spanish. 

Note: If you change the language during editing or viewing, you must re-enter the 

workspace for the setting to take effect. 

4.9.7 Redeem Authorization Code 

Redeem via Settings → Account → Authorization Code → Redeem, or via the 

Permission Card in the upper-right corner of the LCC Studio interface. 

4.10 Account Info 

In the upper-right corner of the LCC Studio interface, account and permission 

information is displayed. Click to open the Permission Card. Click Settings to quickly 

navigate to account settings. 

Permission Card: Displays your LCC permission tier, activated features, and feature 

expiration dates. 



 

Account Information / Settings 

4.10.1 Redeem Authorization Code 

You can also redeem an authorization code from the Permission Card in the upper-

right corner. 

Steps: 

1. Click Redeem Authorization Code to open the dialog. 

2. Paste the authorization code and click Redeem. 

3. Verify the code corresponds to the correct permissions. Click View Benefits to 

see features and duration. If correct, click Confirm Redemption; if incorrect, go back 

and re-enter. 

4. On success, the Permission Card updates to reflect the new permissions. 

 

Redeem Authorization Code 

 

Successful 

 

Authorization Details 



4.11 Announcements 

Important notices and system guides: software updates, feature changes, and 

answers to common questions. 

4.12 Help and Version Info 

Located in the lower-left corner of the LCC Studio interface. Click to access the user 

manual. 

1. User Manual: Click Help to access detailed operation guides and FAQs for the 

current version. 

2. Software Version: Displays the current LCC Studio version for reference. 

5. LCC Editor 

LCC Editor is a desktop application for editing and viewing projects/scenes. It 

organizes work content by "project," supporting import and management of project 

resources, creating and maintaining editing data (annotations, measurements, 

viewpoints, 3D Layout floor plans, Scene Reports) in 3D scenes, and synchronizing 

results to online viewing through publish/update for sharing and delivery. 

LCC Editor integrates editor and viewer capabilities. Edit mode and View mode 

switch seamlessly to meet collaboration needs of different roles within the same 

project. 

5.1 Product Overview 

5.1.1 Edit / View Mode 

LCC Editor — Edit Mode: Configure and edit scenes and assets. Supports 

measurement, annotation, post-processing adjustments, camera path recording and 

video rendering, viewpoint and Scene Report output. Supports overlaying external 

3D assets. 

LCC Editor — View Mode (Viewer): Browse opened LCC scenes in View mode. 

Supports basic navigation, viewing guided tours and Scene Reports, and distance 

and area measurement. Great for presentations, on-site communication, and 

deliverable handoff. 

5.1.2 Download and Installation 

See Section 3: Download and Installation. 

5.2 LCC Editor Homepage 

Double-click to open LCC Editor, or enter from LCC Studio → My Projects. 



 

LCC Editor Homepage 

 

My Projects 

5.2.1 My Projects 

My Projects provides centralized management of created projects displayed as cards. 

Project card and list menu operations: 

Common Operations (unpublished and published): 

1. View: Open project in View mode 

2. Edit: Open project in Edit mode 

3. Rename: Modify project name 

4. Open Folder Location: Open the project directory for viewing project files and 

exports 

5. Delete: Deletes the project folder and its contents 

Draft Projects: 

Publish: Publish the project to the cloud to generate a Web Viewer link for sharing 

and online viewing. 

Two entry points for publishing: 

1. My Projects → project card lower-right quick publish button, or card upper-right 

"..." → Publish 

2. LCC Editor editing interface → Menu Bar → File → Publish 

For publish details, see Section 4.4.3 — Model Settings — Publish. 



 

Entrance to publishing projects 

 

Publish from Editor 

Published Projects: 

1. Online View: Open and view the project in Web Viewer 

2. Update Publication: Sync latest project content to Web Viewer 

3. Publish Management: Open the publish management page for managing 

published links and permissions 

 

Publish 

 

Published projects 

 



5.2.2 Create New Project 

Create a new project workspace. 

Steps: 

1. Click Create New Project in My Projects 

2. Enter project name:  

￮ ≤60 characters 

￮ Supports: Chinese characters, letters, numbers, "_" and "-" 

￮ Does not support: spaces or special characters (% ? # & / \ = : ; < > | " *) 

￮ Non-compliant names may prevent shared links from opening correctly. 

3. Select project storage path 

4. Confirm to enter the Editor interface 

5.2.3 Open Project / Model 

Two types of objects can be opened: 

1. Open Project: Continue editing the project's models and editing data (assets, 

annotations, measurements, viewpoints, etc.). 

2. Open Model File: Open a single model for viewing or temporary editing. For 

long-term maintenance, generate a project via Save. 

5.2.4 Settings 

1. Language: Switch between Simplified Chinese, Traditional Chinese (Hong 

Kong), English, Japanese, Italian, German, and Spanish.  

Note: If language is changed during editing or viewing, re-enter the workspace for the 

setting to take effect. 

2. About: Access the latest version download link and tutorials. Submit feedback 

directly to the LCC team. 

3. Data & Privacy 

5.3 LCC Editor Interface Overview 



 

LCC Editor Interface Overview 

1. Menu Bar:  

File, Edit, Settings, Help — common function entries for file management, 

editing, software settings, and help. 

2. Quick Access Toolbar:  

High-frequency operation buttons for quick use. 

3. Toolbar:  

Editing tools including Selector, Color Grading, Snapshot, Measurement, 

Annotation, 3D Layout, etc. 

4. Mode Switch:  

Toggle between Edit mode and View mode. 

5. View Controller:  

Switch navigation modes, rendering views, origin point, and Height Filter. 

6. Asset List:  

Displays assets in the current project for centralized management. 

7. Properties Panel:  

View and adjust parameters of the currently selected asset. 

8. File Path Display Bar:  

Shows the current project file path. 

9. Status Bar / Prompt Area: 



￮ Displays software version, FPS, and other performance info. 

￮ Shows operation feedback and prompts. 

10. 3D Viewport:  

Scene editing and preview area supporting panoramic browsing, rotation, and 

other interactions. 

5.4 Three Navigation Modes 

LCC Editor provides three navigation modes: Flythrough, Pivot, and Avatar. Click 

the Perspective Switching button to toggle between them. 

In Edit mode: switch between Flythrough and Pivot.  

In View mode: switch between Flythrough, Pivot, and Avatar. 

 

First person flythrough mode 

 

Avatar mode 

5.4.1 First-person Flythrough Mode 

First-person navigation simulating an "as you see it" experience, as if standing in the 

scene looking around. The view follows mouse and keyboard input. Ideal for 

immersive indoor or detail-area browsing. 

￮ Controls: 

 

First person flythrough mode 

Control Function 

W / A / S / D / Q / E Forward / Left / Back / Right / Down / Up 



Shift Sprint 

Scroll wheel Adjust movement speed 

Left-click drag Rotate view 

Right-click drag Pan view 

5.4.2 Pivot Mode 

The camera rotates around a fixed "pivot point" in the scene, suitable for global 

model inspection. 

Since panning the camera also shifts the pivot point, switching suddenly from 

Flythrough to Pivot mode may cause erratic rotation due to center offset. The Origin 

Point function becomes Reset Center Point — click to recalibrate the camera 

position and restore the model center for easier operation. 

￮ Controls: 

 

Pivot mode 

Control Function 

Scroll wheel Zoom 

Left-click drag Rotate around pivot point 

Right-click drag Pan view 

Double-click a point Quick-switch pivot center 

5.4.3 Avatar Mode (View Mode Only) 

Navigate as a virtual character walking through the scene. Only available in View 

mode. Supports immersive flythrough only — measurement and annotation are not 

available. 



￮ Controls: 

 

  Avatar Mode (View Mode Only) 

Control Function 

W / A / S / D  Forward / Left / Back / Right 

Space Jump 

Shift Sprint 

Left-click target position Auto-navigate to location 

Left-click drag Rotate view 

5.5 File 

Open, save, save as, import, export, publish, and exit operations for projects/models 

in Editor. 

 

File 



5.5.1 Open 

Open project files or model files from local storage. 

• Open Project: Continue editing the same work content (models, assets, 

annotations, measurements, etc.). 

• Open Model (e.g., .lcc / .ply): For temporary viewing/editing. For long-term 

maintenance, generate a project via Save. 

Steps: 

1. Menu Bar → File → Open 

2. Select the file to open 

3. Confirm 

5.5.2 Save 

Save the current project's editing state. 

Steps: 

a. Ctrl + S, or Menu Bar → File → Save 

b. Select save location — choose an empty folder or create a new one 

c. Click OK 

1. Auto-Save: Generates project backups for recovery after abnormal exits. 

￮ Auto-save applies to projects only (not temporary projects). 

￮ Backups are stored in the project's autosave folder (e.g., 

D:\Project1\autosave). 

￮ Retains one copy for one month. 

￮ Triggers after 3 minutes of inactivity, repeating every 10 minutes. 

First Save of Temporary Project: If the current work is a temporary project, the first 

save requires: 

a. Enter a project name 

b. Select a project storage path 

c. Confirm to generate a formal project and continue editing 

5.5.3 Save As 

Save the current project as a new version, keeping the original unchanged. 

Steps: 

1. Menu Bar → File → Save As 

2. Select save location — choose an empty folder or create a new one 



3. Click OK 

5.5.4 Import 

Import external resources into the current project/scene. 

Entry: Menu Bar → File → Import 

Currently supported import types: 

• LCC 

• LCC2 

• PLY  

• FBX  

• GLB  

• OBJ 

• Collision 

• 3D Layout 

Notes and Limitations: 

1. LCC and LCC2 files cannot currently be mixed within the same project.  

2. LCC2 does not currently support model editing features (Selector, Crop, Color 

Grading).  

3. File size limits:  

￮ Single import file ≤ 100MB 

￮ Multiple files total ≤ 1GB 

4. Texture resolution limit: ≤ 2048×2048 per file. 

5. Supported texture formats: .jpg and .png only. 

Import .ply（3DGS） 

Open .ply (3DGS) files, loading as viewable/editable scene. 

Entry: Menu Bar → File → Import → PLY 

After opening, the Quick Access area provides translate and rotate controls. Bottom 

controls include reset and save. 

• Translate: Move asset position 

• Rotate: Adjust asset angle 

• Reset: Restore to initial state 

• Save: Save specific view settings; next opening will automatically switch to that 

view 



 

Translate 

 

Rotate 

For .ply files generated within LCC Studio, the software may recognize them as 

editable LCC data and maintain consistent viewing and editing behavior. 

For third-party .ply files, the origin point/initial view may differ, but this generally does 

not affect usage. 

When importing .ply (3DGS), the system may perform internal conversion, which may 

have some impact on performance and rendering quality. 

5.5.5 Export 

Export editing results as deliverable files or data. Export types are based on the 

current version's File → Export menu. 

Currently supported export types: 

• Project 

• LCC 

• LCC2 

• PLY 

• OBJ (under 3D Layout function) 

• JPEG (under 3D Layout function) 

• Collision 

Note: When LCC2 has been imported, exporting to LCC2 and PLY is not supported.  

5.5.6 Publish 

Publish the project as a Web Viewer link for sharing and online viewing. 

Operations are the same as project page publish operations. See Section 4.4.3 — 

Model Settings — Publish. 

5.5.7 Exit 

Close the current software. 



5.6 Edit 

Editing and selection functions for model content. 

 

Edit menu 

5.6.1 Undo 

How to: Press Ctrl + Z, or click the Undo button in the Quick Access Toolbar. 

Supported Undo/Redo operation types: 

1. Selector functions: Select area, Add to Selection, Subtract from Selection, Invert 

Selection 

2. Contrast adjustment 

3. Saturation adjustment 

4. Brightness adjustment 

5. Crop area 

5.6.2 Redo 

How to: Press Ctrl + shift + Z to restore undone operations. 

Supported operation types are the same as Undo. 

Note: Redo is only activated after executing Undo. Once a new operation is 

performed, Redo history is immediately cleared. 

5.6.3 Delete 

Delete selected objects or elements. 

An important tool for cleaning invalid or interfering data from models. Through flexible 

selection methods, you can quickly target areas or objects for removal via cropping, 

improving clarity and usability. 

Cropping does not directly modify original data. Save processed results as a new 



model to preserve original data integrity. 

5.6.4 Add to Selection 

When using any selection mode (Clipping Box, Rectangle, Polygon, Brush), each 

selection replaces the current selection by default. To select multiple areas and keep 

them all: 

How to: Hold Shift while performing a new selection. 

• New selection objects are added to the current selection without overwriting. 

• Selection box edge displays green during add selection. 

 

Original state 

 

Add to selection 

 

Visual guide (green 

outline) 

Best for: 

• Selecting objects from multiple disconnected areas 

• Adding missed content after initial selection 

• Combining different selection tools for complex selections 

5.6.5 Subtract from Selection 

Remove unwanted objects from your current selection. 

How to: Hold Ctrl before performing a new selection. 

• Previously selected objects within the new selection area are deselected. 

Unselected objects remain unaffected. 

• Selection box displays yellow during subtract selection. 

 

Original state 

 

Subtract from selection 

 

Visual guide (yellow box) 



Best for: 

• Refining a broad selection by removing specific areas 

• Working with Add to Selection for precise complex selections 

• Preventing accidental deletion of desired content 

5.6.6 Invert Selection 

Toggle between selecting objects inside vs. outside the selection box. 

How to: In any selection mode, press Ctrl + I to toggle. The selection updates 

immediately. 

 

Select inside 

 

Select outside 

Best for: 

• Selecting everything except a specific area 

• Quick exclusion operations in large scenes 

5.7 Quick Access Toolbar 

Provides Open Folder, Save, Undo, Redo, Move, Rotate, Scale, Switch Scene, and 

other high-frequency operation buttons. 

 

Quick Access Toolbar 

1. Undo: Revert last action 

2. Redo: Restore undone action 

3. Move / Rotate / Scale: Transform target objects 



5.7.1 Switch Scene 

The dropdown list supports switching between scenes in the same project. Each 

scene corresponds to independently viewable and editable content (e.g., different 

imported LCC/PLY files, LCC projects, or scenes created via transition annotations). 

Steps: 

1. Click the Scene Dropdown in the top toolbar. 

2. Select the target scene name. 

3. The system switches to the selected scene and refreshes the display. 

After switching: 

• The 3D view displays the selected scene's content. 

• The Asset List updates to the selected scene's assets and data. 

• Annotations, viewpoints, measurements, 3D Layout floor plans, and Scene 

Reports update with the scene switch. 

5.8 Assets and Properties 

5.8.1 Asset List 

Centralized management of objects and data in the current project/scene (models, 

annotations, guided tours, measurements, etc.). Supports search, locate, grouping, 

visibility toggle, rename, delete, and relink. 

 

Assets 



5.8.1.1 Quick Start 

1. Find and Locate an Object 

a. Find the target entry in the Asset List. 

b. Right-click → Locate. 

c. The 3D view jumps to and selects the asset. 

2. Grouping (Folders) 

a. Create a folder: right-click empty space in the Asset List, or click the Create 

Folder button. 

b. Drag items onto a folder to organize. 

c. Drag items out of a folder to ungroup (if the type supports drag). 

3. Show / Hide Click the eye icon to toggle 3D view visibility of the asset. 

4. Relink Missing Resources 

a. Common when resource files have been moved, renamed, or deleted. 

b. When an item shows a missing resource state (e.g., turns red or shows a 

warning), right-click → Relink. 

c. Select the correct file in the file picker and confirm. 

d. The item restores to normal display. 

5.8.1.2 Basic Operations 

1. Search: Enter keywords in the search box to filter. 

2. Rename: Double-click the item name, edit, press Enter. 

3. Select / Multi-select 

￮ Single-select: Click an item. 

￮ Deselect: Click empty space in the list or 3D view. 

￮ Multi-select: Shift for continuous range; Ctrl for individual item toggle. 

4. Drag and Drop 

￮ Same-level reorder: Drag to new position; release when insertion line 

appears. 

￮ Move into folder: Drag item onto folder. 

￮ Move out of folder: Drag item out (if type supports drag). 

￮ Batch drag: Multi-select then drag (same-level items only; some types don't 

support drag). 

5. Right-click Menu 



Right-click menu varies by asset type. Common items: 

￮ Rename, Delete, Hide/Show 

￮ Create Folder (in empty space or during multi-select) 

￮ Relink (for missing external file resources) 

￮ Clone / Paste (for models, 3D Layout items, folders/groups) 

￮ Ungroup (for folders/groups) 

￮ Export (for Media Render file groups)  

￮ Render (for guided tour viewpoint groups)  

￮ Locate (jump to the location of an asset in 3D view) 

5.8.2 Properties Panel 

View and adjust parameters of the currently selected asset (name, position, rotation, 

scale, export, render, collision toggle, etc.). Auto-syncs with 3D view selection. 

 

Properties panel 

5.8.2.1 Quick Start 

1. Select Asset: Click an object in the Asset List or 3D view. The Properties Panel 



displays that object's properties. 

2. Adjust Values: Enter values in Move/Rotate/Scale fields. The 3D view updates 

in real time. 

3. Toggle Switches: 

￮ Environment Data: Control display of model environment data. Not affected 

by model cropping. Can toggle freely in Editor and Viewer for spatial models with 

environment data. 

￮ Collision: Enable/disable spatial collision. Default: enabled when model 

opens. 

4. Function Buttons: Click Edit / Export / View / Update to enter the corresponding 

function or execute the operation. Available buttons vary by asset type. For editing 

operations, use Confirm / Save within that page. 

5.9 Editing Tools 

Main editing capabilities for the Editor. 

 

Editing tools 

5.9.1 Selector 

Flexible selection for targeted operations. 

5.9.1.1 Brush Selection 

Drag the mouse to "paint" a selection region, which the system projects into 3D from 

your current camera view. All objects within the projected volume are selected. 



How to use: 

a. Click the Brush tool. 

b. Hold left mouse button and drag to paint. 

c. Release to complete selection. 

 

Bru

sh 
 

After selection 

 

Brush selection 

Best for: 

• Local selections of complex-shaped objects where rectangle/polygon would be 

imprecise 

• Fine-tuning add/subtract selections after broad initial selection 

5.9.1.2 Rectangle Selection 

Drag a rectangle on screen. The system projects it from the camera into a 3D 

selection volume. 

How to use: 

1. Click the Rectangle tool. 

2. Hold left mouse button and drag to define area. 

3. Release to complete. 

 

Rectangle 

Select 
 

Rectangle Select 



Best for: 

• Quick rough selection as a first step before refining 

• Efficient edge cleanup — crop sparse, blurry model edges from a macro view 

How Camera Projection Works: Imagine a flashlight shining from your camera 

through the rectangle. Everything illuminated in 3D space gets selected. 

 

Principle of camera projection 

5.9.1.3 Polygon Selection 

Click points to draw a custom closed shape. The system projects it from the camera 

view into 3D. 

How to use: 

1. Click the Polygon tool. 

2. Left-click to place each vertex. 

3. Right-click during drawing to cancel. 

4. Click the first vertex or double-click to close the polygon. 

5. Objects within the projected volume are selected. 

 

Polygon 

select 

 

Polygon select 



5.9.1.4 Clipping Box 

The only true 3D selection method — define a precise cubic region independent of 

camera angle. 

How to use: 

1. Click the Clipping Box tool. 

2. Click three times:  

￮ First click: first corner of the base rectangle 

￮ Second click: opposite corner (forms the base) 

￮ Third click: set height (Z-axis) 

3. A transparent cube appears showing the selection range. 

4. Click ✓ to confirm. 

 

Clipping 

box 
 

Clipping box 

Edit the Clipping Box: 

• Translate: Drag the cube to reposition. 

• Rotate: Spin around any axis. 

• Scale (Stretch): Elongate or compress along any axis. 

• Reset: Discard and recreate from initial state. 

• Confirm: Apply the selection defined by this cube. 



 

Translate 

 

Rotate 

 

Zoom 

Best for: 

• Cleaning floor/ceiling artifacts (e.g., debris, mis-scanned pipes) 

• Isolating a specific room or shelf by encompassing it, then inverting 

• Layered structures (multi-tier shelving, stairwells) without affecting adjacent 

layers 

• Industrial applications requiring predictable, consistent boundary control 

5.9.1.5 Tips and Shortcuts 

View Control Tips 

Selection modes auto-lock the camera to prevent accidental movement. Temporary 

unlock is available. 

1. View Lock: Camera locks automatically in Rectangle, Polygon, and Brush 

selection modes. Mouse drag and WASD keys do not affect the camera while locked. 

2. Temporary Unlock: Hold Alt to unlock the camera: 

• Alt + Left-click drag: Rotate 

• Alt + Right-click drag: Pan 

• Alt + Scroll wheel: Zoom 

• Alt + W/A/S/D: Move 

Release Alt to re-lock and resume selection. 

3. Cancel Selection: While drawing (before completing the shape), press Esc or 

right-click to cancel without affecting existing selections. 

4. Clear All Selections: Press Ctrl + Shift + D to deselect everything. 

Selector Comparison: 

Scenario Recommended Description 

Quick selection of roughly 

regular areas 

Rectangle Simple, efficient, smooth 



Precise selection of complex 

irregular areas 

Polygon Accurate, flexible, avoids mis-

selection 

New users or quick tasks Rectangle Easy to learn 

High precision or edge 

control needed 

Polygon User-defined detailed 

selection 

Shortcut Overview: 

Function Shortcut Description 

Crop selection Delete/Backspace Delete currently selected objects 

Add to selection Shift Hold while selecting to add to existing 

selection 

Subtract from 

selection 

Ctrl Hold while selecting to remove from 

existing selection 

Invert selection Ctrl+I Toggle inside vs. outside selection 

Cancel 

selection 

Esc/Right-click Cancel current drawing (keeps existing 

selection) 

Clear all 

selections 

Ctrl+Shift+D Deselect all 

Undo Ctrl+Z Revert last action 

Redo Ctrl+shift+z Restore undone action 

Temporary view 

unlock 

Alt(hold) Unlock camera for navigation 

Exit cropping 

mode 

Esc Exit cropping (history is cleared) 

5.9.2 Color Grading 

Adjust brightness, contrast, and saturation with real-time preview. Settings save 

automatically and sync across platforms (Web Viewer, View mode). 



 

Color Grading 

5.9.2.1 Usage 

1. Click Color Grading in the toolbar to open the panel. 

2. The panel contains Brightness, Contrast, and Saturation sliders. 

3. Drag sliders to adjust. Changes display in real time and save automatically, 

maintaining the same effect across platforms. 

Tips: 

• Moderate adjustment: Excessive brightness or contrast may cause detail loss. 

• Stylized processing: High saturation suits certain artistic styles but not all scenes. 

Sample results: 

 

Original 

 

Brightness=1 

 

Brightness=-1 

 

Contrast=1 

 

Contrast=-1 

 

Saturation=1 

 

Saturation=-1 



5.9.3 Skybox 

Replace scene background with preset templates for different time-of-day and 

weather atmospheres. Select directly from presets to preview and apply. 

 

Preset skyboxes 

5.9.3.1 Usage 

1. Click Skybox to open the settings panel. 

2. Select a preset template from the panel to preview and apply. 

Note: Skybox conflicts with environment data — only one mode can be 

displayed in subsequent scene loading. 

5.9.4 Photo Tool 

Capture scene snapshots with selectable aspect ratios for quick image output and 

unified export. 

 

Photo Tool 



5.9.4.1 Workflow 

1. Click Photo to enter photo mode. 

2. Switch aspect ratio as needed. Default: 16:9. 

3. Click the capture button to render the current view as an image, added to the 

Media Render folder in the Asset List. 

4. In the Asset List, click to preview. Right-click → Export to save locally. 

5. Double-click an image asset to view the full photo. 

5.9.5 Scene Flythrough 

Camera navigation recording and video output. 

 

Scene Flythrough Recording 

5.9.5.1 Workflow 

a. Click Add Keyframe to record the current camera position and view angle 

on the timeline. 

b. Navigate to the next desired position. Click Add Keyframe. Repeat until all 

keyframes are placed. 

c. Manually set the end time. Default range: 0s–1m55s. 

d. Click Video Output to open the video rendering panel. 

e. In the rendering panel, select your preferred render parameters.  

f. Optionally check Add to Media Render List to make the video available for 

cloud sharing.  

g. Click OK. 



Usage Notes: 

• Select a keyframe and click Delete to remove it. 

• Click Play to preview the recorded camera path. 

• Drag the playhead to scrub through the animation in real time. 

• Adjust start/end times on the timeline to modify the video range. Default: 0s–

1m55s. 

5.9.6 Annotations 

Add clickable annotation points with title, body, media, and links. Two types: Display 

Annotation (shows content) and Transition Annotation (links to another scene). 

 

Add Annotation 

5.9.6.1 Workflow 

1. Add Annotation 

a. Click Annotations in the toolbar to enter annotation mode. 

b. Click the target model surface to place the annotation point. 

c. In the annotation editing panel, select annotation type:  

▪ Display Annotation: Shows title, body, media, and link information. 

▪ Transition Annotation: Links from the current scene to another scene. 

d. Follow the panel prompts to configure content (see details below). 

e. Click Confirm to complete. 

f. Click Annotations again in the toolbar to exit annotation mode. 



2. Display Annotation 

a. Icon Style / Color: Select from dropdown. 

b. Title (required): ≤20 characters. 

c. Body: ≤1,000 characters. 

3. Add Media     

Two methods for adding media: 

a) Snapshot  

1. Click the Snapshot button to enter the annotation snapshot view. 

2. Navigate to adjust the angle, then click Capture to record the current scene view 

and add it as annotation media. Maximum 5 media items. 

3. Click Done to exit the snapshot view and return to the annotation dialog. 

b) Add File 

￮ Click + in the media area to add files. 

￮ Supported formats: JPEG / PNG / MP4 

￮ Maximum 5 files (mixed types allowed) 

￮ Maximum 500MB per file 

5. Add Link: Paste a URL in the link input field. 

6. Transition Annotation 

a. Title (required): ≤20 characters. 

b. Select Target: Choose from existing scenes in the scene list, or add a new 

scene from local files. 

7. Manage 

Edit: 

1. Click the annotation in the Asset List or scene. 

2. Adjust position directly in the 3D view and Properties Panel. 

3. Click Edit in the Properties Panel to open the full editing panel. 

Delete: 

• Select in 3D view or Asset List and press Delete. 

• Or right-click the annotation in the Asset List → Delete. 



 

Click to move 

 

Add Annotation 

 

Right-click to delete 

5.9.7 Viewpoints  

Set preset view angles in the scene. Three types: Navigation Viewpoint, Guided Tour 

Viewpoint, and Area Viewpoint. Created viewpoints can be used for automatic 

flythrough and quick positioning in View mode. 

 

Adding a viewpoint 

5.9.7.1 Workflow 

4. Click Viewpoint in the toolbar to enter viewpoint creation mode. 

5. Click a position in the scene. The system creates a viewpoint and opens the 

settings panel. 

6. Select viewpoint type. The interface displays the corresponding settings. 

7. Configure the relevant parameters. 

8. Click Confirm to create. 

9. Switch to View mode to experience the viewpoint behavior. 



5.9.7.2 Navigation Viewpoint 

Clickable ground indicators for quick switching to preset view angles. 

 

Tour Viewpoint 

Settings: 

• Title: ≤20 characters 

• Height: Slider, 0.1m–3m (default 1.7m) 

• Preview: Real-time preview of the viewpoint's view 

Create and View: 

1. Edit the title (displays in View mode). 

2. Click Confirm to create. 

3. On success:  

￮ New entry appears in the Asset List. 

￮ Translucent ground indicator appears at the viewpoint location. Click to 

animate to that viewpoint. 

5.9.7.3 Guided Tour Viewpoint  

Define an automatic flythrough path that plays in View mode and Web Viewer. 



 

Guided Tour Viewpoint 

Settings: 

• Order: Adjust playback sequence 

• Transition Mode: Transition to next viewpoint (Jump / Linear) 

• Title (required): ≤20 characters 

• Body: ≤100 characters (displays as text annotation during playback) 

• Height: Slider, 0.1m–3m 

• Angle: Default view direction (X/Y) 

• Camera Motion: Lens direction and angle 

• Transition Time: Time from current to next viewpoint (3–10 seconds) 

• Dwell Time: Duration at current viewpoint (3–10 seconds) 

Screenshot:  

• In the preview window, click the screenshot button to render the viewpoint's view 

and add the image to the Media Render list for cloud sharing.  

• Default: 16:9 (1920 × 1080 px), 1080P resolution. 

Export Guided Tour Video 

• Right-click the guided tour viewpoint group in the Asset List → Export 

• Click the guided tour viewpoint group in the Asset List → Export in the Properties 



Panel 

Create and Organize: 

4. Click Confirm to create. 

5. New entry appears in the Asset List. 

5.9.7.4 Area Viewpoint 

Records a view with defined dimensions, used as screenshot source for Scene 

Report export. 

 

Area Viewpoint 

Settings: 

• Title: ≤20 characters 

• Length / Width: Input values; system auto-calculates area. 

• Height: Slider, 0.1m–3m (default 1.7m) 

• Angle: Default view direction (X/Y) 

Screenshot:  

In the preview window, click the screenshot button to render the viewpoint's view and 

add the image to the Media Render list for cloud sharing.  

Default: 16:9 (1920 × 1080 px), 1080P resolution. 

Create and Manage: 

1. Click Confirm to create. 

2. New entry appears in the Asset List. 



5.9.7.5 Modifying Viewpoints 

Edit: 

a. Click the viewpoint in the Asset List or scene. 

b. Adjust position in the 3D view and Properties Panel. 

c. Click Edit in the Properties Panel for the full editing panel. 

Delete: 

￮ Select in 3D view or Asset List → press Delete. 

￮ Or right-click in Asset List → Delete. 

5.9.8 Measurement 

Obtain coordinate, distance, or area data with real-time calculation, unit switching, 

and professional measurement display.Includes: Coordinate Measurement, 

Distance Measurement, and Area Measurement. 

Axis snapping is enabled when the Measurement tool is active (XYZ axis 

snapping). After placing a measurement point, guide lines along the X, Y, and Z 

axes at that point will automatically appear. Guides will also appear when the cursor 

hovers near a measurement point. Moving along a guideline's direction will snap the 

point to that axis, enabling precise horizontal, vertical, or depth-direction 

measurements. 

 

Coordinate Measurement 

 

Distance Measurement 

 

Area Measurement 

5.9.8.1 Workflow 

1. Activate Click Measurement. The measurement indicator appears, confirming 

the function is active. 

2. Select Type: Coordinate, Distance, or Area. 

Coordinate Measurement: 

a. Click the Coordinate button. 

b. Click a point on the model. 

c. If the scene contains RTK data, the system displays absolute coordinates. 

Distance Measurement: 

a. Click the first measurement point. 

b. Click the second point. Distance displays in real time (m). 



c. Right-click to end. 

Area Measurement: 

a. Click the first point. 

b. Click additional coplanar points (minimum 3). 

c. Click the first point to close, or right-click to complete. 

3. Delete 

￮ Hover over the measurement and click the delete button. 

￮ Or select in Asset List → press Delete or right-click → Delete. 

4. Measurement Export  

￮ Select one or more measurements in the Asset List → right-click → Export. 

Supported formats: .csv and .pdf. 

￮ Measurement data can also be included in Scene Reports. In the Scene 

Report tool, switch to measurement data view, select entries, and export them 

as part of the report. 

 

Export measuremets 

 

Switch to 

measurement data 

 

Scene report 

5.9.8.2 Tool Settings 

1. Measurement Units  

Set measurement units for distance and area display. Switch between metric and 

imperial systems and length units. All measurement values update in real time. Metric 

is the default. 

2. Professional Measurement Data  

When enabled for distance measurement, the system calculates real-time offsets 

between two selected points, displayed as dx, dy, dz. Typically used to verify whether 

a line segment is horizontal or vertical. 

5.9.9 3D Layout 

View and edit floor plans for indoor scenes with Spatial Recognition enabled during 

reconstruction. Features: split-screen comparison, 2D/3D switching, mini-map, 



drawing tools. Export as OBJ/JPG. 

Note: 

1. Only available for indoor scenes with Spatial Recognition enabled during 

reconstruction. 

2. Requires 3D Layout permission. 

 

3D Layout  

Check Spatial Recognition 

Entry and Setup: 

First Use: 

1. File → Import → Floor Plan File Directory 

2. Select the semantic-result folder in the project files. 

3. Click OK. 

4. Click the mini-map enlarge button to switch to split-screen 2D view. 

 

Import 3D Floor Plan 



5. Entry: Click 3D Layout in the toolbar. 

 

3D Layout interface 

5.9.9.1 Interface and Tools 

1. Comparison and Views 

• Right panel: floor plan canvas with zoom, pan, drag browsing. 

• Canvas supports 2D/3D view switching and 2D view overlay. 

 

Switch View 

 

Switch between 2D/3D 

 

Switch overlay view 

2. Drawing Toolbar 

Tools: Wall, Door, Window, Text Label, Polygon Drawing, Rectangle Drawing. 



 

Drawing Toolbar 

5.9.9.2 Basic Operations 

1. Selection and Movement 

￮ Select: Click 

￮ Move: Drag 

￮ Deselect: Click empty space 

￮ Cancel/End: Esc or right-click 

￮ Delete: Select → Delete key 

￮ Undo: Ctrl + Z 

2. Canvas Navigation 

• Pan: Right-click drag 

• Zoom: Scroll wheel 

• Rotate: Left-click drag 

3. Rules 

• Right-click behavior: When idle, pans the canvas; when drawing, ends/cancels 

the current action. 

• Exit: Click the active tool icon again to exit drawing mode. 

5.9.9.3 Drawing Tools 

In 2D view, use Wall, Door, Window, Text, Polygon, and Rectangle tools to modify 

and create indoor floor plans. 



General Workflow: 

1. Select a drawing tool. 

2. Draw on the canvas. 

3. Click the tool icon again to exit drawing mode. 

5.9.9.3.1 Wall 

Add missing walls or refine the layout. 

1. Workflow： 

a. Click Wall. 

b. Click to place the start point. 

c. Move mouse to adjust length and angle. 

d. Click to set the end point. 

e. Right-click to finish. 

 

Add wall starting 

point 

 

Move the mouse 

to adjust length 

and angle. 

 

Place wall 

endpoint 

 

Right click to 

complete 

5.9.9.3.2 Door 

Add door elements that snap to and associate with walls. 

1. Workflow： 

a. Click Door. 

b. Click to place the pivot point. 

c. Move mouse to adjust width. 

d. Click to set the endpoint. 

e. Move mouse to set swing direction, left-click to finish. 



 

Click to place the 

pivot point. 

 

Move the mouse 

to adjust width. 

 

Click to set the 

endpoint. 

 

Set the swing 

direction, then 

Left-click to finish. 

5.9.9.3.3 Window 

Add window elements that associate with walls. 

1. Workflow： 

a. Click Window. 

b. Click to place the start point. 

c. Move mouse to adjust width. 

d. Click to set the endpoint. 

 

Click Window 

 

Click to place the 

start point. 

 

Move the mouse 

to adjust width. 

 

Click to set the 

endpoint. 

5.9.9.3.4 Text Label 

Add information labels such as room names or numbers. 

Workflow： 

1. Click T. 

2. Click the canvas to place the text box. 

3. Double-click to activate the text box. 

4. Enter text. 

5. Click empty space or right-click to finish. 

Resize: 

1. Click to select the text box. 

2. Drag corners to adjust font size. 



3. Click outside to finish. 

 

Click to place 

text box 

 

Double click to 

activate textbox 

 

Enter text 

 

Right click or click 

outside to finish 

5.9.9.3.5 Polygon Drawing 

Create irregular areas and labels by drawing custom closed shapes point-by-point. 

Workflow: 

a. Select Polygon Drawing. 

b. Click to place control points. 

c. Double-click to complete the shape. (Note: Right-click cancels the current 

drawing without saving.) 

d. Double-click the text box to edit the label. 

e. Click empty space to exit the tool. 

 

Click [Polygon Drawing] 

 

Click to place points 

 

Double-click to end  

 

Click text box to edit  

 

Edit 

 

Exit 



5.9.9.3.6 Rectangle Drawing 

Quickly add rectangular areas with automatic text labels. 

Workflow: 

a. Select Rectangle Drawing. 

b. Click and drag to draw the rectangle. 

c. Release the mouse to finish the shape. 

d. Click empty space to complete the command. 

e. Double-click the text box to edit the label. 

 

Hold mouse and 

drag rectangle 

 

Release to 

complete 

 

Click empty 

space to 

complete 

 

Double click to 

edit text 

5.9.9.3.7 View Angle Quick Controls 

Quickly straighten and rotate by 90° rotation. 

5.9.9.4 3D Layout Export 

In Split-screen mode, export your floor plan as a 3D model (OBJ) or a 2D image 

(JPG). 

• Workflow: File ->Export -> Select OBJ or JPEG -> Confirm. 

5.9.10 Scene Report  

Compile 3D Layout floor plans and viewpoint content from the current project into a 

template-based report for viewing, publishing, or local export. 

• Supports local export in JPEG and PDF formats.  

• Optionally includes viewpoints and measurement data.  



 

Scene Report 

5.9.10.1 Workflow 

1. Create 

a. Click Scene Report to enter the editing panel. 

b. Fill in content:  

▪ Title (required): ≤20 characters 

▪ Body: ≤1,000 characters 

▪ 3D Layout: If the project contains floor plan data, it can be selected. 

▪ Optional content: Select viewpoints or measurement data to include.  

c. Click Confirm to complete. 

2. Manage 

View and Edit: 

￮ Click the Scene Report entry in the Asset List. 

￮ In the Properties Panel, open the preview and edit the report. 

￮ Export: In the Properties Panel, export the Scene Report. Two formats: 

JPEG and PDF.  

￮ Delete: Select in Asset List → press Delete or right-click → Delete. 

Post-Publication: 

￮ After publishing, view the report in View mode. 



￮ If modified after publishing, use Update to sync the latest version to View 

mode. 

5.10 View and Navigation 

5.10.1 View Direction Axis 

Located in the upper-right corner of the 3D viewport. Click axis labels to snap to 

standard views. Click the axis center to reset orientation. 

 

View Direction Axis 

5.10.2 Switch View 

Switch the model view to point cloud view for more direct inspection of structure, data 

density, or scan precision. 

Point cloud view displays the model as dense points without surface textures. Useful 

for data inspection, accuracy comparison, or viewing structural information only. All 

navigation modes remain available. 

 

Model view 

 

Point cloud view 

5.10.3 Origin Point 

In Flythrough mode, reset the origin point. Supports Return to Origin and Reset 

Origin. 



 

Origin Point 

1. Reset Origin 

a. Navigate to the desired position in Flythrough view. 

b. Click Confirm. The origin resets to the current view angle. 

 

Reset Origin Point 

 

Confirmation 

2. Return to Origin 

a. Click Return to Origin to jump to the set origin. 

b. If no origin has been set, jumps to the scene's default initial origin. 

5.10.4 Height Filter 

Height Filter mode controls model visibility along the Z-axis by adjusting height range, 

allowing you to view or edit the model from a sandbox-like top-down perspective. 

1. Click the Height Filter button to enter height filter mode. 

2. Drag the height adjustment sliders from the top and/or bottom to set the visible 

range. 

3. Click Height Filter again to exit. The current height state is preserved on exit. 



 

Height Filter 

5.11 Settings and Help 

5.11.1 Settings 

Configure scene-level settings in Editor. 

 

Settings 



1. Language:  

Simplified Chinese, Traditional Chinese (Hong Kong), English, Japanese, Italian, 

German, and Spanish.  

2. Capture Trajectory:  

For scenes generated by the latest version, view the device capture path. Available in 

all terminals (Editor / Viewer). 

3. Show Grid Plane:  

2D working plane for alignment and detail design in Editor. Editor only. 

4. Rendering:  

Performance mode (faster) / Quality mode (clearer, higher hardware requirements). 

5. Graphics API:  

Switch if rendering shows tearing, flickering, or other display artifacts. 

6. Measurement Settings:  

a. Switch between metric and imperial, and set length units. All measurements 

update in real time.  

b. Professional Measurement Data: display dx / dy / dz axis offsets for more 

precise measurement. 

5.11.2 Help 

1. Tutorials: Access the official user manual and capture guide. 

2. Community: Platform for user feedback and exchange. 

3. Official Website: XGRIDS official website for the latest versions and updates. 

5.12 View Mode (Viewer) 

Browse LCC scenes with basic navigation, viewpoint-guided tours, Scene Reports, 

and measurement. Suitable for presentations, on-site communication, and 

deliverable handoff. 

5.12.1 Interface Overview 

Includes: Menu Bar, Toolbar, Guided Tour Viewpoints (if set by editor), Scene Report 

(if set by editor). 



 

View mode interface 

Toolbar 

The LCC model viewing toolbar includes: Origin Point, Point Cloud Toggle, 

Annotations, Measurement, Perspective Switching, Scene Report, Height Filter. 

 

Web viewer Toolbar 

Origin Point 

Reset camera to the scanner's initial capture position for viewing from the original 

capture angle. 

Point Cloud Toggle 

Switch to point cloud view for structure, density, or precision inspection. 

View Annotations 

1. Click Annotations in the toolbar to open the annotation list. 

2. Hover over a scene annotation for a brief summary. 



3. Click an annotation to view full details.  

￮ Show/Hide: Hover over an annotation in the list to reveal the eye icon. Click 

to toggle visibility. 

￮ Expand Details: Click to view full details (images, videos, text, links). 

Measurement 

Perform temporary measurements or view publisher-saved measurement data. 

Workflow 

For detailed instructions see: 5. LCC Editor - 5.9 Edit Tools - 5.9.8 Measurement - 

5.9.8.1 Workflow 

Usage Notes: 

1. Temporary measurements are valid for the current session only. Data clears 

when the function is closed or the model is exited. 

2. Publisher measurements can be viewed but not edited. 

3. Professional Measurement Data: When enabled, displays dx, dy, dz offsets for 

horizontal/vertical verification. 

 

Without pro measurement 

 

With pro measurement 

Perspective Switching 

Toggle between Flythrough, Pivot, and Avatar modes. 

Height Filter 

Control model visibility along the Z-axis for sandbox-like viewing. 

5.12.2 Navigation Viewpoints 

White ground indicators are viewpoints added by the editor. Click to quickly switch to 

the preset view angle and position. 



 

Navigation viewpoints 

5.12.3 Guided Tour 

The guided tour consists of multiple guided tour viewpoints set by the editor in 

sequence, used for automatically browsing key areas of the scene. 

 

Guided Tour Viewpoints 

5.12.4 Scene Report 

View existing Scene Reports for the project, including floor plans, viewpoint 



screenshots, and dimension/area information. 

 

Scene Report 

 

 

 

 


